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57 ABSTRACT 

A user interface is described for an image computing work 
Station for electronically arranging the components of a 
Special effects job, Such as image-compositing, from a 
plurality of image Sequences obtained by the Scanning of 
motion picture film. The interface controls the ordering of a 
plurality of image Sequences into a hierarchy of background 
and foreground image Sequences, with each Sequence being 
composed of frames whose appearance imitates the frames 
of a motion picture film. The hierarchical image Sequences 
are displayed adjacent to each other in a windowing envi 
ronment So that the frames thereof Visually align on a 
frame-to-frame basis. The interface includes means for 
varying the hierarchical order and the adjacency of the 
image Sequences So that different frames thereof are brought 
into visual alignment with each other, whereby the image 
Sequences are correctly ordered as to hierarchy and adja 
cency for a special effect. As an additional feature, the 
interface provides a flow diagram for Specifying the type and 
order of Special effect operations applied to each frame. 

14 Claims, 11 Drawing Sheets 
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COMPOSTER INTERFACE FOR 
ARRANGING THE COMPONENTS OF 
SPECIAL EFFECTS FOR A MOTION 

PICTURE PRODUCTION 

This is a continuation of application Ser. No. 08/773,372, 
filed Oct. 7, 1991 now abandoned. 

TECHNICAL FIELD 

This invention relates to the field of motion picture 
production and, in particular, to the production of motion 
picture Special effects. 

DESCRIPTION RELATIVE TO THE PRIOR ART 

Special effects play an important role in the Story telling 
process of theatrical motion-picture films. The use of Special 
effects has increased rapidly with the advances made by 
leading companies and individuals in the field. An example 
of a special effect called compositing is shown in FIG. 1. A 
foreground camera produces a foreground color negative 1 
of a foreground Scene usually shot against a deep-blue 
backing. In a laboratory process involving color Separations, 
a foreground positive 2 and a high contrast hold-back matte 
3 are extracted from the foreground color negative 1. A 
black-center matte 4 (positive) is then printed from the 
hold-back matte 3. Meanwhile a background camera pro 
duces a background negative 5, and from that a background 
positive 6 is made. The black-center matte 4 and the 
background positive 6 are bi-pack printed to form a bi-pack 
positive 7, which is a background image with an opaque 
Silhouette exactly matching the foreground Subject. The final 
composite negative 8 is obtained by optically printing the 
foreground positive 2 and the bi-pack positive 7, which 
exactly emplaces the foreground object into the opaque area 
in the bi-pack positive. AS may be appreciated, this tech 
nique is done on a large number of motion picture images 
constituting a motion picture Scene, due to its temporal 
dimension, this is Sometimes referred to as the travelling 
matte process. Historically, Such effects have been produced 
by traditional optical printing methods, which tend to be 
very time-consuming and costly because of the number of 
laboratory and optical printing Stages required. 

The animation industry has experimented with electronic 
compositing procedures that can foreshorten Some of the 
time lag due to optical effects. For instance, in U.S. Pat. No. 
3,749,822, an analog animation System is disclosed in which 
Stock foreground and background film Scenes are Scanned, 
electronically Superimposed, and reconverted to an optical 
image on a cathode ray tube that is photographed by a 
motion picture camera. This is, however, a relatively low 
definition System of limited manipulation capability that is 
not suitable for the standards of today. Elaborate interfaces 
have subsequently been disclosed (see U.S. Pat. No. 4,952, 
051) for handling and editing of drawings created in 
Sequence, especially for animation, with the use of elec 
tronic graphics equipment. Electronic blue-Screen matting 
using complex analog color difference algorithms (see U.S. 
Pat. No. 3,595,987) have been proposed for motion picture 
applications, but have largely been relegated to Video pro 
cessing because of process limitations. 

The Video post production industry utilizes electronic 
compositing techniques based on digital technology in order 
to alleviate Some of the problems present in analog video 
resolution systems. For example, in U.S. Pat. No. 4,266.242, 
a hardware-intensive Video special effects generator is 
described in which input Video signals are positioned at any 
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2 
location, thus varying Size and position in a composite 
output image, by manipulating Storage addresses in a 
memory. Special effects disclosed include compressing in 
horizontal and Vertical dimensions, X-y translation, and 
display according to a priority Sequence (i.e., of one portion 
of one input image in the composite output image to the 
exclusion of other video input images). Further representa 
tive video special effects disclosures include U.S. Pat. No. 
4,602,286 (a digital compositer wherein one image is keyed 
into another image by utilizing plural frame Stores), U.S. 
Pat. No. 4,713,695 (image superposition obtained without 
exceeding Standard television peak-to-peak picture Signal 
amplitudes), U.S. Pat. No. 4,876,600 (a composite image is 
composed from cameras, raster graphic generator, and mass 
storages), and U.S. Pat. No. 5,008,755 (combined mix/wipe 
and size/position transition effects are controlled from a 
common memory to cooperate on a “common time line'). 

Within the motion picture industry, high definition tele 
Vision equipment is being considered for electronic creation 
of special film effects. The high definition format, however, 
has lower Spatial resolution, incompatible frame rate, limited 
contrast range, different colorimetry, and an interlaced line 
Structure as compared to film. There is a need, therefore, for 
a higher-quality System to Serve as a bridge for motion 
picture film images to move into the high-resolution digital 
domain for Subsequent image manipulation, and then back 
onto film for distribution and theatrical display. Such a 
System was proposed at the 131st Technical Conference of 
the Society of Motion Picture and Television Engineers on 
Oct. 24, 1989 in a paper entitled “High Resolution Elec 
tronic Intermediate System for Motion Picture Film” (by B. 
Hunt, G. Kennel, L. DeMarsh, and S. Kristy), and Subse 
quently published in the SMPTE Journal, March 1991, pp. 
156-161. This paper proposes both a high-resolution elec 
tronic intermediate System and the establishment of a digital 
image Standard for motion-picture film. This System and 
Standard would provide an interactive tool to manipulate 
digitized motion-picture film images. It would operate 
“transparently” between film input and film output, with no 
Visible image-quality compromises in between. FIG. 2 is a 
block diagram of the basic components of Such a high 
resolution intermediate System, Separated into three opera 
tional Stages: a film input Scanning Stage 10, an image 
manipulation Stage 12, and a film output recording Stage 14. 
The basic components of these Stages include a high reso 
lution film Scanner 16 for Scanning input Special effects 
elements (films) 18a, 18b, 18c, a plurality of digital data 
recorders 20a, 20b, 20c used in the various Stages, an image 
computing WorkStation 22; and a high resolution film 
recorder 24 for outputting back to film. The operational 
Stages are linked by digital tape recordings 26a, 26b; the 
final output is an exposed composite film Strip 28. 
The film Scanner 16 disclosed in the Hunt et all article is 

a high-resolution charge-coupled device (CCD) film Scanner 
using a trilinear color sensor array with about 4000 photo 
Sites for fully capturing three color records from the film. 
The parameters and System specifications were further 
described in an unpublished presentation entitled “Devel 
opment of the High Resolution Electronic Intermediate 
System”, which was given by G. Kennel and M. Inchalik to 
an SMPTE Technical Conference on Oct. 16, 1990. The 
operational speed of the scanner 16 would be about 3 
Seconds per frame for Academy aperture film (2 Seconds for 
Scanning and recording and 1 Second for frame advance and 
registration), and the resulting signals would be digitized, in 
density space, to 10 bits/color. The film recorder 24 is a 
high-resolution laser film recorder using three visible light, 
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gas lasers (458 nm Argon, 543 nm Helium Neon, and 633 
nm Helium Neon lasers) for recording the output image on 
Eastman Color Intermediate film, thereby generating the 
exposed composite film 28. 

The image computing WorkStation 22 consists of a con 
ventional computer workstation based on a SUN platform 
with VME backplane and a UNIX operating system. A 
transputer-based image processing accelerator 30 provides 
high-Speed image manipulation, a parallel disk array 32 
provides a large image memory, a Video disk recorder 34 
provides the capability to make a “video workprint', and a 
high resolution graphics display 36 provides visual interface 
with the operator. Hard copy output is provided by a high 
resolution thermal printer 38. Besides image compositing, 
the WorkStation allows a variety of image manipulation 
capabilities, including color grading of each Scene or indi 
vidual elements in a Scene; the combination of computer 
generated images with film images, “painting to Selectively 
modify portions of an image or to eliminate artifacts like 
dirt, Scratches, or guide wires, digital Special effects Such as 
"page turns' ; and titling that is generated “word-processor 
Style” and then combined with any Scene in a variety of 
different on-line font styles and colors. 

Achievement of these capabilities for the workstation 22 
requires careful design, not only to ensure that the WorkSta 
tion hardware has the necessary performance to handle the 
high resolution images, but also to ensure that the ergonomic 
and workflow concepts are correct. In connection with the 
latter, one of the characteristics of Successful film optical 
houses is their use of a formal and planned environment. 
Their management Structure provides for effective use of 
expensive resources, reduces waste and rework and ensures 
Short cycle times. The use of careful planning and efficient 
workflow management should ideally be preserved with the 
introduction of digital technology via the image computing 
WorkStation 22. In particular, the WorkStation should be 
designed to be easy for film optical technologists to learn to 
use. By designing the WorkStation to use familiar concepts 
and processes the learning curve can be made easier to 
negotiate. For these reasons, though digital technology may 
be poised to revolutionize the motion picture industry, the 
ergonomics of the workstation (i.e., the user interface) 
should conform to most of the processes and terminology 
familiar to the film optical world. 
The Video post production industry has long been 

involved in electronic editing of Video signals, that is, the 
Sequential joining of Separate Scenes into a whole program. 
The ergonomics of the Video editor, however, is aimed 
toward a kind of “user-friendliness” that has application to 
program assembly. In U.S. Pat. No. 4,612,569, for instance, 
a plurality of frames from plural input television Sources are 
displayed on a monitor as if looking at a plurality of 
“cinefilms' arranged side-by-side. The “films' are moved 
forwardly or backwardly at any desired Speed to determine 
the editing points. In addition, Some video editors (see U.S. 
Pat. Nos. 4,538,188 and 4,685,003) provide a storyboard 
output including a Sequence of pictorial labels, designating 
the serially connected scenes, which describe the flow of the 
Story. Unfortunately, Such editing techniques are designed to 
emulate end-to-end "splicing” and are not useful in charac 
terizing the “parallel” relationships, e.g., of coincident fore 
ground and background Scenes, that must be properly visu 
alized to obtain a Special effect. 

SUMMARY OF THE INVENTION 

An object of the invention is to provide means to inter 
actively manipulate digitized motion picture images 
arranged in a "parallel”, or cross-over, hierarchy. 
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4 
A further object is to produce a System that could be easily 

used by film-effects Specialists and yet provide a rich and 
full-featured environment for the creation of high resolution 
digital effects. 
A further object is to model film optical processes by 

incorporating Several formalities into the WorkStation user 
interface: first, to manage the images with terminology and 
Symbology familiar to the film effects editor; Secondly, to 
line up the images to visually define the Special effects task, 
and thirdly, to graphically chart the type and order of 
operations applied to each frame. 
A further object is to incorporate the visual definition of 

the Special effects task and the graphical charting of the type 
and order of operations into respective windows that provide 
Virtually all of the functionality required to create digital 
visual effects. 

An automated interface has been developed for the Visual 
representation and direct manipulation of the components 
that constitute a special effects job. Each component consists 
of a sequence of frames (images) that mimic the appearance 
of a film Strip. The compositer user interface displayS 
miniature images within the constituent frames as accurate 
representations of the actual images. The user can manipu 
late the components using mouse and keyboard operations, 
which include: changing the fit or timing of a component; 
changing the position of a component in the hierarchy; 
deleting, duplicating, cutting, copying, or pasting of com 
ponents as well as frames, re-arranging the order of the 
frames in a component; changing the Speed of a component; 
and Saving a job's configuration at any Stage for future 
C-USC. 

There are at least three major benefits in this approach 
over using optical techniques. Firstly, Since the user works 
with digital images instead of film, manipulation operations 
are simplified and do not require making physical changes to 
the original medium. For example, the virtual “cutting” and 
re-arranging of frames in a film Strip happen in Software and 
are therefore easily reversible. Secondly, delays that are 
unavoidable in the optical domain (e.g., sending a composite 
film roll to a lab for overnight printing) disappear altogether. 
The user can See the effect of the operations on the Screen in 
a matter of a few seconds. This enables the user to be much 
more productive and to achieve better results by going 
through more cycles than achievable in the optical domain. 
Finally, jobs are maintained in a compact and Self-contained 
form, enabling the user to treat them as objects that can be 
readily Stored, edited, and duplicated. For example, to create 
multiple versions of a job, the user can make duplicates of 
the job file and make changes to them as necessary, leaving 
all the digital images intact. 

Accordingly, the invention pertains to a System for elec 
tronically arranging the components of a Special effects job 
for a motion picture production from a plurality of image 
Sequences obtained by the Scanning of motion picture film. 
The System includes the ordering of a plurality of image 
Sequences into a hierarchy of background and foreground 
image Sequences, with each Sequence being composed of 
frames whose appearance imitates the frames of a motion 
picture film. The hierarchical image Sequences are displayed 
adjacent to each other So that the frames thereof Visually 
align on a frame-to-frame basis. The System includes means 
for varying the hierarchical order and the adjacency of the 
image Sequences So that different frames thereof are brought 
into visual alignment with each other, whereby the image 
Sequences are correctly ordered as to hierarchy and adja 
cency for a special effect. As an additional feature, the 
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System specifies the type and order of Special effects opera 
tions applied to each frame by means of a flow diagram 
showing the order of the Special effects. 

BRIEF DESCRIPTION OF THE DRAWINGS 

The prior art and the invention will be described in 
relation to the drawings, in which: 

FIG. 1 is a schematic illustration of a special effect known 
as image compositing as practiced in the optical arts, 

FIG. 2 is a block diagram of a high resolution electronic 
intermediate System for motion picture film, as described in 
the prior art; 

FIG. 3 is a diagram of the compositer window component 
of a user interface as Specified in accordance with the 
invention for use with the intermediate system of FIG. 2; 

FIG. 4 is a diagram of the flow graph component of the 
user interface as Specified according to the invention for use 
with the intermediate system of FIG. 2; 

FIG. 5 explains the symbols available for the flow graph 
of FIG. 4; 

FIG. 6 is a diagram illustrating a vertical change in the 
hierarchy of the image Sequences shown in FIG. 3; 

FIG. 7 is a diagram illustrating a horizontal change in the 
adjacency of the image Sequences shown in FIG. 3; 

FIG. 8 is a diagram showing several ruler selections for 
the compositer window shown in FIG. 3; 

FIG. 9 shows the change in the appearance of the com 
positer window for Several Zoom levels, 

FIG. 10 shows the condense mode of operating the 
compositer window; and 

FIG. 11 is an illustration of dynamically changing the 
hierarchy of the image Sequences of FIG.3 by using hidden 
Segments. 

DETAILED DESCRIPTION OF THE 
INVENTION 

Inasmuch as an electronic intermediate System has been 
disclosed in the prior art heretofore cited, the present 
description will be directed in particular to elements forming 
part of, or cooperating more directly with, an interface 
System in accordance with the present invention. Elements 
not specifically shown or described herein may be Selected 
from those known in the art. In particular, the algorithms for 
Special effects, which are not themselves parts of the 
invention, are not Specifically described herein and may be 
selected from well-known disclosures in the prior art. For 
instance, algorithms bearing on the actual process of elec 
tronic compositing are described in Such patents as U.S. Pat. 
Nos. 3,595,987; 4,007,487; 4,100,569; and 4,344,085; all in 
the name of Petro Vlahos, the teachings of which are 
incorporated by reference herein. 

The invention is characterized by the line up proceSS 
illustrated by the compositer window 40 in FIG. 3 and the 
flow graph structure 42 illustrated in FIG. 4 (FIG. 5 defines 
the symbols involved in the flow graph 42 of FIG. 4). The 
compositor window 40 and the flow graph structure 42 
appear as rectangular, on-Screen frames shown by the graph 
ics display 36 (see FIG. 2) and through which a user can 
View the progreSS of a special effects job. These frames are 
run in a conventional windowing environment, that is, an 
applications program interface commonly associated with a 
graphical user interface (Such as windows, pull down menus, 
Scroll bars or Scroll boxes, and So on). The manipulating of 
the information within the compositer window 40 and the 
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6 
flow graph Structure 42 is controlled by a user who interacts 
with the image computing workstation 22 (see FIG. 2) in 
real-time through an input device 37 Such as a mouse, Stylus, 
or keyboard. The compositer window 40 and the flow graph 
Structure 42 represent a Software controlled user interface 
that presents the end-user (typically an optical technician) 
with tools and concepts that a perSon of Such skills would 
feel comfortable with. 
The compositer window 40 is the component of the user 

interface that enables the user to line-up and manipulate the 
components of a Special effects job using Simple and intui 
tive mouse (or Stylus) and keyboard operations. The com 
ponents of the Special effects job are obtained by Scanning 
Specially prepared filmstrips of backgrounds and fore 
grounds (using CCD film Scanner 16, FIG. 2), by accessing 
previously stored Scenes, or by generating Scene elements 
with the image computing WorkStation 22. In the line-up 
process, the compositer window 40 acts as a virtual lightbox 
to allow the structure of an effects job to be quickly defined. 
The window 40 (light box) displays components as film 
strips that can be moved around freely to establish the 
horizontal fit and vertical croSS-Over hierarchy. Referring to 
FIG. 3, four image sequences (hereinafter referred to as 
elements) are displayed in the compositer window 40: a 
background element 54, a first foreground element 56, a 
second foreground element 58, and a composite element 60. 
Each element 54, 56, 58, 60 consists of a sequence of frames 
(54a, 54b ...; 56a, 56b. . . ; 58a, 58b...; 60a, 60b ...). 
Depending on the original Scanned film, the frame repre 
Sentation on the Screen mimics either VistaVision (8 sprocket 
holes on either side of each frame) or Academy (4 sprocket 
holes on either side of each frame). In either case, the aspect 
ratio is 1.5 and the frames run horizontally. Each frame is 
displayed as a low resolution "postage-Stamp' image in its 
film strip. This is, for example, a 64x96 pixel (24-bits RGB) 
image obtained by Subsampling the original Scanned image. 
Frame “postage Stamp' images can be hidden if desired by 
invoking an appropriate menu Selection (to be discussed 
later). 
The other main component of the user interface is the 

flow-graph 42 (FIG. 4). The flow-graph controls the type and 
order of operations applied to each frame by Specifying 
exactly what operations are to be performed and in what 
order they are applied to the elements of a job to produce the 
final composite. An initial configuration of the flow graph, 
showing a simple compositing operation, is constructed 
automatically by the System. Each operation is represented 
by an icon (called a node). The user can Subsequently edit 
the flow-graph by adding nodes to the flow graph, deleting 
nodes, and changing the parameters associated with a node. 
FIG. 5 Summarizes the operations and their associated icons. 
Additionally, the user may combine any Set of these opera 
tions to produce more complicated operations. Defining 
further operations to be carried out for an effects job 
involves Selecting an effects-process icon from the tool-kit 
of icons illustrated in FIG. 5. The tool-kit is provided in a 
pull-down list. Operating in the windows environment, the 
icon is Selected from the toolkit and placed in the appropriate 
position within the flow-graph. This icon is then inserted 
into the list of operations to be performed by the worksta 
tion. 

Each operation is accordingly represented by an icon 
(FIG. 5) and has an associated set of parameters. For 
instance, the Second row 43 of icons in the flow graph 42 
includes a color-grading icon 44 for adjusting the color of 
the input "planet' image, a rotation icon 45 for rotating the 
image, and a matting icon 46 for extracting the “planet' 
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image according to Some predetermined algorithm. Each 
icon has an associated parameter, i.e., a color value for icon 
44, a rotation angle for icon 45, and a matting algorithm for 
icon 46. After the processing in row 43, a compositing icon 
47 specifies the combination of the “planet' image with the 
“background image. In Such manner the compositing 
operation continues until the final composite image 48 is 
obtained. The completed flow graph 42 represents an actual 
operation that can be electronically actuated upon a set of 
elements by appropriate menu Selection (to be discussed). 

All compositing-related activities are initiated from the 
window 40, which displays the constituent elements of a job. 
Each element is graphically represented as a Strip of film: the 
top-most Strip represents the background (BG) element 54, 
the bottom-most Strip represents the composite Sequence 60 
and the intermediate Strips represent the foreground (FG) 
elements 56, 58. The name of each element is left justified 
above each element. For example, in the window shown in 
FIG. 3, the BG element 54 is called BKG, and the first FG 
element is called PLANET. The second foreground element 
58 is called MOON, and the composite sequence 60 is called 
COMPOSITE. Frame numbers for each element appear 
above it. These numbers are useful because not all elements 
run in Sequential frame numbers (the frames may have been 
rearranged due to reversing or cutting and pasting). Both the 
element names and the frame numbers can be hidden if 
desired (refer to the View menu, which will be described 
later). Typically there is one background (BG) element 54 
and one or more foreground (FG) elements 56, 58. The aim 
is to extract Subjects of interest from the foreground ele 
ments and insert them into the background element, thereby 
giving the illusion that the foreground Subjects were origi 
nally present in the background. AS described earlier, this 
proceSS is called compositing; it is usually carried out layer 
by layer, where during each pass the next foreground ele 
ment is composited with the result of the previous pass 
(intermediate background). The optical technique illustrated 
in FIG. 1 is illustrative of one layer; FIG. 3 is illustrative of 
two layers. A three-layer process is illustrated by the 
example of the flow graph 42 in FIG. 4. 

The hierarchical ordering of the elements and the Start/ 
Stop position of each foreground relative to the background 
element is called the croSS-Over hierarchy. In particular, the 
priority of compositing will be determined by the croSS-Over 
hierarchy, that is, if FG element 58 is higher in the hierarchy 
(and therefore in priority) than the FG element 56, then the 
images being composited out of the FG element 58 will 
overlie and take precedence over (be “in front of) the 
images in the FG element 56 in the final composited image 
sequence 60. This is shown in FIG. 3 by the MOON Fg 
element 58 appearing in front of and obscuring the PLANET 
Fg element 56 in the COMPOSITE element 60. 

Prior to compositing, though no part of the present 
invention, the elements are usually color-graded in order to 
achieve a mutually uniform color balance (this compensates 
for the different light conditions in which the elements were 
exposed and for the different film stock characteristics). The 
compositing process itself requires the production of mattes 
for foreground elements. These are gray-Scale or bitonal 
images that are used to extract a foreground before com 
positing it with a background. Background, foreground, and 
matte imageS may have to go through other forms of 
processing before/after compositing. Examples include: 
geometric transformations (reposition, resize, Scale, flip), 
Sharpen, blur, and Soft-edging of mattes. AS mentioned 
before, the compositing algorithms are not part of this 
invention and may be found in Such documents as the 
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VlahoS patents previously mentioned. Likewise, Suitable 
geometric transformations and the like are well known in the 
prior art. 

In the optical World, all the elements for a special effects 
Sequence, their production-related information (e.g., 
producer, director, roll numbers, dates), the cross-over 
hierarchy, the color-grading parameters, and all the other 
processes that the elements/mattes have to go through are 
stored in a box, called a job box. The job box, therefore, 
contains Sufficient information for the Special effects 
Sequence to be regenerated at any future date. This concept 
is carried over into the present user interface, where a job 
box is an object that gathers information pertaining to a job. 
Accordingly, the compositer window 40 and the flow graph 
42 present the user with a visual and structured view of the 
information in a job box, and provide functionality for 
manipulating the job box. 
The compositer is invoked in a conventional manner by 

choosing the compositer command from a top level menu 
(not shown). This opens a blank compositer window 40. To 
nominate a job box to work on, the user drags a tool box file 
from a file manager window (not shown) and drops it into 
the compositer window 40, or alternatively specifies the job 
box using an open command. The elements of the Special 
effects in the job box then appear in the compositer window 
40. 
The user interface permits many different operations to be 

applied to the various components of the job. Operations are 
applied by choosing commands from the pull-down menus 
shown in Table I, which are actuated by engaging the 
pull-down menu buttons 61 at the top of the compositer 
window 40. (The “job box” menu, which is not hereinafter 
described, provides commands for viewing the contents of 
the current job box, opening, closing, Saving, reverting 
changes to a job box, and quitting the compositer window). 

TABLE I 

PULL DOWN MENU 

EDIT VIEW TOOLS 

undo partitions flow graph 
cut ZOOil sequence preview 
copy ruler units frame preview 
paste show mini-movie 
delete composite column 
segment composite partition 
select open loop composite 
ewese paint 
restore 
printing 
preferences 

The user interfaces with the menus by use of a three-button 
mouse represented by the input device 37 in FIG. 2. The 
buttons are called: SELECT (for selecting objects), ADJUST 
(for extending a selection), and MENU (for obtaining pop 
up menus). Alternatively, a stylus can be used with a 
graphics tablet to Support the same three functions. The 
mouse input is provided to a conventional graphics user 
interface with Standard features including clipboard, desk 
accessories, Scroll boxes, object dragging and So on. 

Elements longer than the width of the window 40 can be 
scrolled horizontally using a scrollbar 62 at the bottom of the 
window 40. Because the elements 54, 56, 58, 60 are aligned 
together, horizontal Scrolling affects all elements. (In effect, 
the horizontal scrollbar 62 is indicative of the position 
within the BG element 54, and the FG elements 56, 58 are 
aligned to the BG element.) Vertical Scrolling(using a Scroll 
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bar 64 to the right of the window) affects FG elements 56, 
58 only, and is useful when the job has more FG elements 
(more than the two shown in FIG. 3) than there is room for 
their simultaneous display. Horizontal and vertical Scrolling 
are preferably both discrete, in the sense that it should not be 
possible to scroll by half a frame or half an element, as the 
compositing operation is based on frame-to-frame adja 
cency. 

The window can be resized by dragging any of its four 
corners. Resizing may affect the number of frames displayed 
per element and/or the number of FG elements 56, 58 
displayed within the window. Resizing is preferably 
discrete, So that half-frame, half-element, and large blank 
areas are avoided. Also a minimum window Size of 3 
elements by 3 frames, and a maximum window Size (no 
greater than the Screen size of the graphics display 36) are 
enforced to avoid meaningleSS displayS. 

Each element has an associated icon 66 positioned to its 
extreme left. The icon content indicates the position of the 
element in the cross-over hierarchy (0 for the BG element 
54; 1, 2, etc., for the FG elements 56, 58; and x for the 
composite element 60). An element icon is selected by 
clicking SELECT on it, in which case it is highlighted. Only 
one element icon 66 can be selected at a time. An element 
is deselected by clicking ADJUST on it, or by clicking 
SELECT outside the element icons 66, or by selecting 
another element icon 66. An element can also be selected/ 
deselected by clicking SELECT/ADJUST on its film base 
(i.e., any part of the film Strip except where the images 
appear). 
The following operations can be applied to the currently 

selected elements 54, 56,58, or 60: 
Choosing Delete from the Edit menu causes the element 

to be deleted from the job; 
Choosing Cut from the Edit menu causes the element to 

be moved onto a "clipboard', i.e., a storage area where 
the element can be temporarily Saved; 

Choosing the Paste command on the Edit menu allows an 
element on the “clipboard” to be pasted before, over, or 
after another element; 

Choosing Reverse from the Edit menu causes the order of 
the element's frames to be reversed; 

Choosing Restore from the Edit menu causes all changes 
to the element to be restored; 

Choosing Printing from the Edit menu displays a pop-up 
window (not shown) for Setting the speed of the ele 
ment (e.g., double printing or skip printing); 

Choosing Mini Movie from the Tools menu displays a 
pop-up window (not shown) for previewing the ele 
ment in real-time, using the low resolution images 
forming the Virtual image frames in the compositer 
window 40; and 

Choosing Sequence Preview from the Tools menu dis 
plays a pop-up window (now shown) for previewing 
the element in real-time, using Video resolution images. 

As shown in FIG. 6, the position of an element in the 
hierarchy can be changed by Vertically dragging its film Strip 
(using SELECT) and dropping it on another element. The 
effect of this operation is that the two elements are Swapped. 
When an element is dragged in this manner, the cursor 
changes to a bidirectional vertical arrow 70 and a ghost 
outline 72 of the element and its name follow the movement 
of the mouse as feedback to the user. This action changes the 
Vertical component of the croSS-Over hierarchy. Dragging 
and dropping an element between two other elements, 
moves the element to between the two nominated layers. If 
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the control key (on keyboard 37, FIG. 2) is held down while 
dragging, the operation is interpreted as a copy: the element 
is copied and the copy is inserted into the target layer. These 
operations can also be applied to element icons 66 to get 
exactly the same results. As a restriction, the composite 
element can neither be moved to another layer nor dupli 
cated. 
AS Shown in FIG. 7, an element can also be dragged 

Sideways to adjust its position (fit) in relation to other 
elements. This action changes the horizontal component of 
the cross-over hierarchy (also referred to as the adjacency of 
the elements). To do this, the user drags the film Strip (using 
SELECT) left or right and drops it at the desired location. 
The element is then Snapped to the new position So that its 
frames remain aligned with other elements frames. AS with 
Vertical dragging of elements, the cursor changes to a 
bidirectional horizontal arrow 74 and a ghost outline 76 of 
the element follows the movement of the mouse. The frame 
numbers are also shown inside the ghost. 
A frame is selected by clicking SELECT on the frame 

image area. Selected frames are then highlighted by a green 
box around the frame image. Multiple frames can be 
selected by clicking ADJUST on them. A selected frame can 
be deselected by clicking ADJUST on it. Clicking SELECT 
outside the frames deselects all currently Selected frames. 
The following operations can be applied to the currently 
Selected frames: 

Choosing Delete from the Edit menu causes the frames to 
be deleted from the element; 

Choosing Cut from the Edit menu causes the frames to be 
moved onto a clipboard; 

Choosing the Paste command on the Edit menu allows the 
frames on the clipboard to be pasted to before, over, or 
after other frames, 

Choosing Reverse from the Edit menu causes the order of 
the frames to be reversed; 

Choosing Segment from the Edit menu causes the frames 
to be hidden or shown; 

Choosing Frame Preview from the Tools menu displays a 
pop-up window (not shown) for previewing the 
Selected frame in its original resolution; and 

Choosing Paint from the Tools menu invokes a paint tool 
for touching up the original image for the Selected 
frame. 

As shown in FIG.3, a ruler 78 permanently appears above 
the elements 54, 56, 58, 60 and contains the frame numbers 
1, 2, 3, . . . for the entire job (starting from 1). As the user 
Scrolls horizontally through the elements of a job, the ruler 
Scrolls with the elements. The default unit for the ruler 78 is 
the frame numbers. This can be changed to time code, 
VistaVision footage, or Academy footage (by accessing 
“ruler units” on the View menu, Table I). The different ruler 
formats are illustrated in FIG. 8. 
The ruler 78 also provides a way of visualizing the 

partitions of a job. A job can be divided into a set of 
partitions, where each partition represents a Subsequence of 
the job. Each partition has its own flow graph (see FIG. 4), 
thereby enabling each partition to be treated (composited) 
differently. The first partition in FIG. 8, for example, consists 
of frames 1-4. The left and right boundaries of a partition are 
respectively, marked by a right-pointing Symbol 80a and a 
left-pointing symbol 80b. Partitions are sequentially num 
bered (starting from 1); a partition number appears half-way 
in between its end-markers in a number box 82. All jobs 
contain at least one partition (covering the entire length of 
the job). 
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A partition is selected by clicking SELECT on its number 
box 82 or on its shaft 84. Only one partition can be selected 
at a time. A Selected partition can be deselected by clicking 
ADJUST on it, or by clicking SELECT outside it, or by 
Selecting another partition. The flow graph of a partition can 
be viewed by double-clicking its partition number using 
SELECT (or by using the Flow Graph command in the 
TOOLS menu, Table I). The user can alter the boundaries of 
a partition by dragging(using SELECT) its end-markers to 
the left or the right. Partition boundaries are always aligned 
with frame boundaries. Holding the control key down while 
dragging a partition marker causes it to be replicated to a 
new position (i.e., divides the partition into two 
Subpartitions). A partition marker can be removed by drag 
ging it out of the ruler. After each insertion or deletion of a 
marker, the partitions are automatically renumbered. The 
first and the last partition markers can neither be deleted nor 
moved. 
As shown in FIG. 3, a palette 86 of four tools appears 

above the Sequence ruler. A tool is chosen by clicking 
SELECT on it, in which case the cursor changes to the shape 
of that tool. The relevance of the tools is as follows: 

The pointer tool 88a is the default tool and is used for all 
the activities described earlier (e.g., Selection); 

The diamond tool 88b is used for creating new partition 
markers, 

The key tool 88c is used for marking keyframes; and 
The comment tool 88d is used for attaching arbitrary 
comments to frames. 

More particularly, after selecting the diamond tool 88b, 
the user can click SELECT on the ruler to insert a pair of 
markers at that position. The effect is that the clicked 
partition is divided into two Subpartitions. A keyframe, 
which is marked by the key tool 88c, is a frame of special 
interest used, for example, to decide the appropriate color 
grading parameters. An element may have any number of 
key frames. In the present interface, key frames are used as 
a means of Signaling to the user the important frames. To 
mark key frames, the user first selects the key tool 88c and 
then clicks SELECT inside a frame (this can be a frame from 
any element). If the frame is not already a keyframe, then it 
becomes one and a key Symbol appears above it (Such as the 
symbol 89 in FIG. 3). Key symbols can also be attached to 
ruler slots by clicking SELECT on the ruler. The comment 
tool 88d can be used as a way of documenting and convey 
ing information related to the Special effect being created. To 
do this, the user first selects the tool and then clicks SELECT 
inside a frame (this can be a frame from any element). If the 
frame has no comment, then a comment Symbol appears 
above it. The comment attached to a frame can be edited by 
double-clicking its Symbol using SELECT, causing a pop-up 
comment block (not shown) to appear. 
By selection of the appropriate tool from the TOOLS 

menu (Table I), the operations outlined in the flow-graph 42 
may be obtained and viewed either for a column of frames 
(the “composite column” command) or for a partition (the 
“composite partition” command). The flow-graph can be 
operated at reduced resolutions to Speed up interaction. For 
example, to quickly arrive at the Structure of an effect for a 
key frame, it is not necessary to process the images at full 
resolution. The flow-graph allows this initial work to be 
executed at reduced resolution, for example, at one-sixteenth 
resolution. The parameters for processes Such as color 
grading and blue-Screen compositing can be interactively 
adjusted with results appearing on the Screen more rapidly 
than when in high resolution. Once the desired effect is 
achieved, high resolution is Selected and the final composite 
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can be seen at full resolution. Finally, after a key-frame has 
been Successfully composited at high-resolution, the “open 
loop composite” command (TOOLS menu, Table I) can be 
invoked to automatically process Subsequent frames. A 
motion preview capability further allows the composited 
Sequence to be transferred to and viewed from the digital 
video disk recorder 34 (FIG. 2). 
The elements in a job can be viewed at a number of Zoom 

levels (e.g., 1:1=100%, 2:1=50%, and 4:1=25%). To Zoom 
out, the user clicks SELECT in a down icon 90a to the 
extreme left of the ruler. Similarly, to Zoom in, the user 
clicks in an up icon 90b. Alternatively, the “Zoom' selection 
may be made from the VIEW menu (Table I). The Zoom 
level is displayed between the two icons. Each Zoom in or 
out changes the display scale by a factor of 2. FIG. 9 shows 
the window appearance at 50%, and 25% Zoom levels. 
Frame “postage Stamp' images are also displayed at these 
Zoom levels (but not shown in FIG. 9). All functionality 
remains the same, except that at 25% Zoom frame numbers 
above the elements and Symbols are permanently hidden. 
Clicking on the Zoom ratio 90c (between the two Zoom 
arrows) causes it to be highlighted and changes the display 
of the film Strips to the condense mode. In the condense 
mode, only the first and the last frame of each partition is 
shown; thus each element can be completely visualized 
without the need to Scroll through the complete element (this 
is especially useful for a job with long elements). The 
condense mode can also be accessed from the VIEW menu 
with the “partition” command (Table I). FIG. 10 illustrates 
the condense mode at 100% Zoom. 
Any set of frames from an element can be hidden by the 

user. The effect of this operation is that the nominated frames 
become transparent: they do not take part in the compositing 
process. To hide a Set of frames, the user first Selects them 
and then choose Segment(Hide) command from the Edit 
menu (Table I). Hidden frames are drawn in the same color 
as the film base. Hidden frames can be shown again by 
choosing the Segment(Show) command. Hiding of frames is 
useful for creating dynamic cross-over hierarchies, in which 
the order of the elements alternate for the length of the job. 
For example, given two elements F1 and F2 in a job, 
suppose that for the first partition F1 should be in front of F2 
and then for the second partition F2 should be in front of F1. 
To achieve this, F1 is duplicated and the copy is placed in 
front of F2. Then segments from F1 and its copy are 
selectively hidden and partitioned to obtain the reversed 
effect. FIG. 11 illustrates this for two elements called BKG 
(F1) and FG (F2). 
The preceding description of the user interface constitutes 

a verbal, System level Specification of the interface. 
Consequently, the interface may be programmed according 
to conventional practice to provide the features illustrated in 
the drawings and outlined in the specification. While the 
user interface has been designed to assist portability of the 
System to many different hardware platforms, this is not a 
critical aspect of the claimed invention. Likewise, issues of 
Speed are of economic value but do not directly bear on the 
technical merits of the interface, particularly the function 
ality that allows most of the special effects to be carried out 
using just two windows, namely, the compositer window 40 
and the flow graph window 42. 
The compositer interface is implemented, in the preferred 

embodiment, in C++, an object-oriented language described 
in The C++ Programming Language, by B. Stroustrup, 
Addison-Wesley, Reading, Mass., 1986. The interface is run 
on a SUN SparcStation running UNIX, X-Window/Xview 
(see The X Window System, O'Reilly & Associates, Vols. 
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0-7, Sebastapol, Calif., 1990). For its image display 
capabilities, the workstation uses a Tech Source frame buffer 
(GDS-3900 Series Graphics Display Processor Board, Tech 
Source Inc. Altamonte Springs, Fla.) with a 24-bit RGB 
plane and an overlay 8-bit plane for windowing. 

While not essential for practice of the claimed invention, 
the WorkStation employs a multi-layer Software architecture. 
The layerS provide isolation between the outer user interface 
layerS and the inner hardware dependent layers. This layer 
ing allows flexibility in porting the Software to varied 
hardware platforms. The workstation will, therefore, have 
the same look and feel whether it runs on a high performance 
accelerated machine or on a lower cost WorkStation. This 
flexibility also allows new developments in hardware tech 
nology to be adopted rapidly. The user interface layer is 
written using the object oriented language C++ and makes 
use of the industry-standard graphical user interface, Open 
Look. This layer gathers the user's intent and converts it into 
a request Stream called the Motion-picture Interface Protocol 
or MIP. Screen design and workflow management are there 
fore contained within the user interface layer. In the pre 
ferred embodiment, the user interface is modelled on film 
optical concepts but the architecture will permit different 
user interface personalities to be accommodated, e.g., com 
puter graphics, or Video. 

In the preferred embodiment, the user interface attaches to 
the image processing layer via an MIP server. The Server 
takes the stream of MIP requests from one or a number of 
user interfaces and performs the required image processing 
functions. The image processing layer is written in C++ and 
performs largely a resource management role. The layer 
converts the requests to a stream of low level calls on the 
hardware layer. These calls are part of a library called the 
Image Processing Application Programming Interface, or 
IP-API. 

The invention has been described in detail with particular 
reference to a presently preferred embodiment, but it will be 
understood that variations and modifications can be effected 
within the Spirit and Scope of the invention. 
What is claimed is: 
1. A user interface System for electronically arranging the 

components of a Special effects job for a motion picture 
production from a plurality of image Sequences obtained by 
the Scanning of motion picture film, Said System comprising: 

a) a virtual light box interface for lining up the compo 
nents of the Special effects job, Said virtual light box 
interface comprising: 
means for ordering a plurality of image Sequences into 

background and foreground image Sequences, each 
Sequence being composed of frames that imitate the 
frames of a motion picture film; 

means for displaying the image Sequences adjacent to 
each other So that the frames thereof Visually align 
on a frame-to-frame basis, and 

means providing for user variation of the adjacency of 
the image Sequences So that different frames thereof 
are brought into visual alignment with each other, 
Such that the image Sequences are ordered by the 
user as to adjacency for one or more special effects, 
and 

b) a flow graph interface visually displaying the type and 
order of Special effects-process operations applied to 
the frames, Said flow graph interface providing for user 
Specification and control of what operations are to be 
performed and in what order the operations are applied 
to the components of the Special effects job. 

2. A System as claimed in claim 1 wherein Said virtual 
light box interface includes an additional image Sequence 
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with additional frames, and wherein Said ordering means 
includes ordering the additional image Sequence into a 
hierarchy of background, foreground, and additional image 
Sequences, the additional frames forming an image Sequence 
in which a special effect is displayed. 

3. A System as claimed in claim 2 wherein Said image 
Sequences include a background Sequence and a plurality of 
foreground Sequences ordered into a hierarchy that illus 
trates a Special effects priority of the foreground Sequences, 
Said means providing for user variation of the adjacency of 
the image Sequences also providing for user variation of the 
hierarchy of the foreground image Sequences So that the 
priority of the foreground Sequences can be changed by the 
USC. 

4. A System as claimed in claim 1 further including means 
for partitioning the background and foreground Sequences 
into a plurality of image partitions each being designated for 
a respective special effect. 

5. A System as claimed in claim 4 wherein Said displaying 
means only displays the first and last frame of each image 
partition. 

6. A System as claimed in claim 1 wherein Said image 
Sequences are displayed via Said virtual light box interface 
in a window in a windowing environment. 

7. A System as claimed in claim 6 wherein Said displaying 
means is operable in a plurality of Zoom modes, each mode 
displaying a different number of frames of each image 
Sequence within the window. 

8. A user interface System for electronically arranging the 
components of a Special effects job for a motion picture 
production from a plurality of image Sequences obtained by 
the Scanning of motion picture film, Said System comprising: 
means for ordering a plurality of image Sequences into a 

hierarchy of background and foreground image 
Sequences, each Sequence being composed of frames 
that imitate the frames of a motion picture film; 

means for displaying the hierarchical image Sequences 
adjacent to each other So that the frames thereof Visu 
ally align on a frame-to-frame basis, 

means providing for user variation of the adjacency of the 
image Sequences So that different frames thereof are 
brought into Visual alignment with each other, whereby 
the image Sequences are ordered by the user for a 
Special effect; 

means for generating and displaying an additional image 
Sequence with additional frames, wherein Said ordering 
means includes means for ordering the additional 
image Sequence into a hierarchy of background, 
foreground, and additional image Sequences, and the 
additional frames form an image Sequence in which the 
Special effect is displayed; and 

means providing for user Specification and control and 
Visual display of the type and order of Special effects 
operations applied to each frame of the background and 
foreground image Sequences. 

9. A System as claimed in claim 8 wherein Said image 
Sequences include a background Sequence and a plurality of 
foreground Sequences ordered into a hierarchy that illus 
trates a Special effects priority of the foreground Sequences, 
Said adjacency varying means further including means for 
user variation of the hierarchical arrangement of the image 
Sequences So that the illustrated priority of the foreground 
Sequences can be changed by the user. 

10. A system as claimed in claim 8 further including 
means for partitioning the background and foreground 
Sequences into a plurality of image partitions each being 
designated for a respective Special effect. 
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11. A System as claimed in claim 8 wherein Said means 
providing for user Specification and control and Visual 
display includes means for interactively establishing and 
displaying a flow diagram having interconnected Special 
effects-process icons. 

12. An interface method for electronically visualizing a 
Special effects job for a motion picture production from a 
plurality of image Sequences obtained by the Scanning of 
motion picture film, Said method comprising the Steps of: 

a) lining up the image sequences into components of the 
Special effects job, the lining up Step comprising: 
ordering a plurality of image Sequences into a hierarchy 

of background and two or more foreground image 
Sequences, each Sequence being composed of frames 
that imitate the frames of a motion picture film; 

displaying the hierarchical image Sequences adjacent to 
each other So that the frames thereof Visually align 
on a frame-to-frame basis, 

user variation of the adjacency of the image Sequences 
so that different frames thereof are brought into 
Visual alignment with each other, whereby the image 
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Sequences are ordered by a user as to adjacency for 
a special effect; and 

displaying an additional image Sequence representative 
of the Special effect for the ordered image Sequences, 
and 

b) user specifying and visual displaying of the type and 
order of Special effects-process operations applied to 
the frames, thereby showing what operations are to be 
performed and in what order the operations are to be 
applied to the components of the Special effects job. 

13. An interface method as claimed in claim 12 further 
including the Step of partitioning the background and fore 
ground Sequences into a plurality of image Segments each 
being designated for a special effect. 

14. An interface method as claimed in claim 12 further 
including the Step of providing for user changing of the 
hierarchical arrangement of the foreground image Sequences 
relative to the background image Sequence, whereby the 
image Sequences are ordered by the user as to hierarchy for 
a special effect. 


